Model Debugger for Fast Models
User Guide

Release Information

<table>
<thead>
<tr>
<th>Issue</th>
<th>Date</th>
<th>Confidentiality</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>31 May 2014</td>
<td>Non-Confidential</td>
<td>New document for Fast Models v9.0, from DUI0314P for v8.3.</td>
</tr>
<tr>
<td>B</td>
<td>30 November 2014</td>
<td>Non-Confidential</td>
<td>Update for v9.1.</td>
</tr>
<tr>
<td>C</td>
<td>28 February 2015</td>
<td>Non-Confidential</td>
<td>Update for v9.2.</td>
</tr>
<tr>
<td>D</td>
<td>31 May 2015</td>
<td>Non-Confidential</td>
<td>Update for v9.3.</td>
</tr>
<tr>
<td>E</td>
<td>31 August 2015</td>
<td>Non-Confidential</td>
<td>Update for v9.4.</td>
</tr>
<tr>
<td>F</td>
<td>30 November 2015</td>
<td>Non-Confidential</td>
<td>Update for v9.5.</td>
</tr>
<tr>
<td>G</td>
<td>29 February 2016</td>
<td>Non-Confidential</td>
<td>Update for v9.6.</td>
</tr>
<tr>
<td>H</td>
<td>31 May 2016</td>
<td>Non-Confidential</td>
<td>Update for v10.0.</td>
</tr>
<tr>
<td>I</td>
<td>31 August 2016</td>
<td>Non-Confidential</td>
<td>Update for v10.1.</td>
</tr>
<tr>
<td>J</td>
<td>11 November 2016</td>
<td>Non-Confidential</td>
<td>Update for v10.2.</td>
</tr>
<tr>
<td>K</td>
<td>17 February 2017</td>
<td>Non-Confidential</td>
<td>Update for v10.3.</td>
</tr>
<tr>
<td>1100-00</td>
<td>31 May 2017</td>
<td>Non-Confidential</td>
<td>Update for v11.0. Document numbering scheme has changed.</td>
</tr>
<tr>
<td>1101-00</td>
<td>31 August 2017</td>
<td>Non-Confidential</td>
<td>Update for v11.1.</td>
</tr>
<tr>
<td>1102-00</td>
<td>17 November 2017</td>
<td>Non-Confidential</td>
<td>Update for v11.2.</td>
</tr>
<tr>
<td>1103-00</td>
<td>23 February 2018</td>
<td>Non-Confidential</td>
<td>Update for v11.3.</td>
</tr>
<tr>
<td>1104-00</td>
<td>22 June 2018</td>
<td>Non-Confidential</td>
<td>Update for v11.4.</td>
</tr>
<tr>
<td>1104-01</td>
<td>17 August 2018</td>
<td>Non-Confidential</td>
<td>Update for v11.4.2.</td>
</tr>
<tr>
<td>1105-00</td>
<td>23 November 2018</td>
<td>Non-Confidential</td>
<td>Update for v11.5.</td>
</tr>
<tr>
<td>1106-00</td>
<td>26 February 2019</td>
<td>Non-Confidential</td>
<td>Update for v11.6.</td>
</tr>
<tr>
<td>1107-00</td>
<td>17 May 2019</td>
<td>Non-Confidential</td>
<td>Update for v11.7.</td>
</tr>
<tr>
<td>1108-00</td>
<td>05 September 2019</td>
<td>Non-Confidential</td>
<td>Update for v11.8.</td>
</tr>
<tr>
<td>1109-00</td>
<td>28 November 2019</td>
<td>Non-Confidential</td>
<td>Update for v11.9.</td>
</tr>
<tr>
<td>1110-00</td>
<td>12 March 2020</td>
<td>Non-Confidential</td>
<td>Update for v11.10.</td>
</tr>
</tbody>
</table>

Non-Confidential Proprietary Notice

This document is protected by copyright and other related rights and the practice or implementation of the information contained in this document may be protected by one or more patents or pending patent applications. No part of this document may be reproduced in any form by any means without the express prior written permission of Arm. No license, express or implied, by estoppel or otherwise to any intellectual property rights is granted by this document unless specifically stated.

Your access to the information in this document is conditional upon your acceptance that you will not use or permit others to use the information for the purposes of determining whether implementations infringe any third party patents.

THIS DOCUMENT IS PROVIDED “AS IS”. ARM PROVIDES NO REPRESENTATIONS AND NO WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY, Satisfactory Quality, Non-Infringement or Fitness for a particular purpose WITH RESPECT TO THE DOCUMENT. For the avoidance of doubt, Arm makes no representation with respect to, and has undertaken no analysis to identify or understand the content and scope of, third party patents, copyrights, trade secrets, or other rights.
This document may include technical inaccuracies or typographical errors.

TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT WILL ARM BE LIABLE FOR ANY DAMAGES, INCLUDING WITHOUT LIMITATION ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF ANY USE OF THIS DOCUMENT, EVEN IF ARM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

This document consists solely of commercial items. You shall be responsible for ensuring that any use, duplication or disclosure of this document complies fully with any relevant export laws and regulations to assure that this document or any portion thereof is not exported, directly or indirectly, in violation of such export laws. Use of the word “partner” in reference to Arm’s customers is not intended to create or refer to any partnership relationship with any other company. Arm may make changes to this document at any time and without notice.

If any of the provisions contained in these terms conflict with any of the provisions of any click through or signed written agreement covering this document with Arm, then the click through or signed written agreement prevails over and supersedes the conflicting provisions of these terms. This document may be translated into other languages for convenience, and you agree that if there is any conflict between the English version of this document and any translation, the terms of the English version of the Agreement shall prevail.

The Arm corporate logo and words marked with ® or ™ are registered trademarks or trademarks of Arm Limited (or its subsidiaries) in the US and/or elsewhere. All rights reserved. Other brands and names mentioned in this document may be the trademarks of their respective owners. Please follow Arm’s trademark usage guidelines at http://www.arm.com/company/policies/trademarks.

Copyright © 2014–2020 Arm Limited (or its affiliates). All rights reserved.


110 Fulbourn Road, Cambridge, England CB1 9NJ.

LES-PRE-20349

Confidentiality Status

This document is Non-Confidential. The right to use, copy and disclose this document may be subject to license restrictions in accordance with the terms of the agreement entered into by Arm and the party that Arm delivered this document to.

Unrestricted Access is an Arm internal classification.

Product Status

The information in this document is Final, that is for a developed product.

Web Address

www.arm.com
### Contents

**Model Debugger for Fast Models User Guide**

**Preface**

- About this book ................................................................. 7

**Chapter 1**  
**Introduction**

- 1.1 About Model Debugger .......................................................... 1-10
- 1.2 Key features ........................................................................... 1-11
- 1.3 Retargetable debugger .............................................................. 1-12
- 1.4 Cluster debugging .................................................................. 1-13

**Chapter 2**  
**Using Model Debugger**

- 2.1 Launching Model Debugger ..................................................... 2-15
- 2.2 Model Debugger application windows ...................................... 2-24
- 2.3 Debug views for source code and disassembly ......................... 2-41
- 2.4 Debug views for registers and memory ...................................... 2-49
- 2.5 Debug views for pipelines ....................................................... 2-56
- 2.6 Watch window and Expression Evaluator ................................. 2-61
- 2.7 Breakpoints in Model Debugger ................................................ 2-64
- 2.8 Model Debugger sessions ........................................................ 2-68
- 2.9 Preferences dialog box ............................................................ 2-69

**Chapter 3**  
**Installation and Configuration**

- 3.1 Linux installation procedure .................................................... 3-72
- 3.2 Windows installation procedure ................................................ 3-74
This preface introduces the Model Debugger for Fast Models User Guide.

It contains the following:

- *About this book on page 7.*
About this book

This document describes how to use the Model Debugger GUI for CADI-compliant processor models.

Using this book

This book is organized into the following chapters:

**Chapter 1 Introduction**
This chapter introduces Model Debugger and describes its key features.

**Chapter 2 Using Model Debugger**
This chapter describes how to use Model Debugger.

**Chapter 3 Installation and Configuration**
This chapter describes how to install and configure a standalone version of Model Debugger. Model Debugger is automatically installed with Fast Models.

**Chapter 4 Shortcuts**
This chapter describes shortcuts available in Model Debugger.

Glossary

The Arm® Glossary is a list of terms used in Arm documentation, together with definitions for those terms. The Arm Glossary does not contain terms that are industry standard unless the Arm meaning differs from the generally accepted meaning.

See the Arm® Glossary for more information.

Typographic conventions

*italic*
Introduces special terminology, denotes cross-references, and citations.

*bold*
Highlights interface elements, such as menu names. Denotes signal names. Also used for terms in descriptive lists, where appropriate.

*monospace*
Denotes text that you can enter at the keyboard, such as commands, file and program names, and source code.

*monospace italic*
Denotes a permitted abbreviation for a command or option. You can enter the underlined text instead of the full command or option name.

*monospace italic*
Denotes arguments to monospace text where the argument is to be replaced by a specific value.

*monospace bold*
Denotes language keywords when used outside example code.

<and>
Encloses replaceable terms for assembler syntax where they appear in code or code fragments. For example:

```
MRC p15, 0, <Rd>, <CRn>, <CRm>, <Opcode_2>
```

**SMALL CAPITALS**
Used in body text for a few terms that have specific technical meanings, that are defined in the Arm® Glossary. For example, IMPLEMENTATION DEFINED, IMPLEMENTATION SPECIFIC, UNKNOWN, and UNPREDICTABLE.

Feedback
Feedback on this product

If you have any comments or suggestions about this product, contact your supplier and give:

- The product name.
- The product revision or version.
- An explanation with as much information as you can provide. Include symptoms and diagnostic procedures if appropriate.

Feedback on content

If you have comments on content then send an e-mail to errata@arm.com. Give:

- The number 100968_1110_00_en.
- If applicable, the page number(s) to which your comments refer.
- A concise explanation of your comments.

Arm also welcomes general suggestions for additions and improvements.

Note

Arm tests the PDF only in Adobe Acrobat and Acrobat Reader, and cannot guarantee the quality of the represented document when used with any other PDF reader.

Other information

- Arm® Developer.
- Arm® Information Center.
- Arm® Technical Support Knowledge Articles.
- Technical Support.
- Arm® Glossary.
Chapter 1
Introduction

This chapter introduces Model Debugger and describes its key features.

It contains the following sections:

- **1.1 About Model Debugger** on page 1-10.
- **1.2 Key features** on page 1-11.
- **1.3 Retargetable debugger** on page 1-12.
- **1.4 Cluster debugging** on page 1-13.
1.1 About Model Debugger

Model Debugger for Fast Models is a fully retargetable debugger for scalable cluster software development. It is designed to address the requirements of SoC software developers.

Model Debugger has an easy to use GUI front end and supports:

- Source-level debugging.
- Complex breakpoints.
- Advanced symbolic register display.
- Customized window layout.

Model Debugger can connect to any Component Architecture Debug Interface (CADI) compliant model.

Model Debugger supports full cluster debugging, and multiple instances of Model Debugger stay fully synchronized while debugging different cores running within a single system.

![Model Debugger session: main window with debug windows](image)

**Figure 1-1** A Model Debugger session: main window with debug windows

*Related information*

Component Architecture Debug Interface v2.0 Developer Guide
1.2 Key features

This section describes the key features of Model Debugger.

- Full simulation control on C-statement and instruction levels.
- C-source level display with syntax highlighting.
- Integrated variable browser.
- Low-level disassembly display.
- Call stack and backtrace.
- Complex register display with unlimited register groups and compound registers.
- Memory windows with support for multiple memory spaces and bit widths.
- Breakpoints on register and memory locations with complex conditions.
- Advanced search capabilities.
- Intuitive GUI with fully customizable window layout.
- Project management to store debugging sessions including window layout, open files, and breakpoints.

Note

Fast Models targets do not support all of these features.
1.3 Retargetable debugger

Model Debugger supports completely retargetable debugging of any target that supports the CADI debug interface.

All target-related information, such as the disassembly and resources like register files and flags, is contained in the target model library. Model Debugger communicates with the target using CADI to retrieve the static target-specific information, for example a register file. It can then determine the target state and control execution.

Model Debugger can attach to and debug target components that are part of Fast Models systems. It can also debug any stand-alone target model library that has a CADI interface.

Related information

Component Architecture Debug Interface v2.0 Developer Guide
1.4 Cluster debugging

Model Debugger supports cluster debugging and can be attached to an arbitrary number of core targets in a cluster system.

If attached to a processor model, Model Debugger automatically loads the debug information for the respective target processor and colors all views.

Model Debugger can save the appearance for each target that is based on project files. Information that can be saved and restored includes:

- Debugger geometry.
- Complete layout and geometry of all views.
- Breakpoints.

Related references

2.8 Model Debugger sessions on page 2-68
Chapter 2
Using Model Debugger

This chapter describes how to use Model Debugger.

It contains the following sections:
• 2.1 Launching Model Debugger on page 2-15.
• 2.2 Model Debugger application windows on page 2-24.
• 2.3 Debug views for source code and disassembly on page 2-41.
• 2.4 Debug views for registers and memory on page 2-49.
• 2.5 Debug views for pipelines on page 2-56.
• 2.6 Watch window and Expression Evaluator on page 2-61.
• 2.7 Breakpoints in Model Debugger on page 2-64.
• 2.8 Model Debugger sessions on page 2-68.
• 2.9 Preferences dialog box on page 2-69.
2.1 Launching Model Debugger

This section describes how to launch Model Debugger, and how to start models and connect to them from it.

This section contains the following subsections:

- 2.1.1 Launching from the command line on page 2-15.
- 2.1.2 Launching from System Canvas on page 2-17.
- 2.1.3 Launching Model Debugger separately on page 2-21.
- 2.1.4 Starting simulations and connecting automatically on page 2-22.

2.1.1 Launching from the command line

To launch Model Debugger from the command line, type `modeldebugger` with options and arguments.

<table>
<thead>
<tr>
<th>Short</th>
<th>Long option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>--cyclelimit cycles</td>
<td>Set a limit on the number of system cycles for a simulation in non-GUI mode. Use the --nogui option to enable this option.</td>
</tr>
<tr>
<td></td>
<td>--debug-isim isim_system</td>
<td>Start <code>isim_system</code> and connect Model Debugger to the simulation.</td>
</tr>
<tr>
<td></td>
<td>--debug-sysc systemc</td>
<td>Start <code>systemc</code> simulation and connect Model Debugger to the simulation.</td>
</tr>
<tr>
<td>-T</td>
<td>--timelimit time</td>
<td>Set a time limit for a simulation in non-GUI mode. Use the --nogui option to enable this option.</td>
</tr>
</tbody>
</table>
| -a    | --application filename | Load the application file `filename`. To target cores in cluster systems, prefix the name with the path to the instance. For example, `foo.bar.core=dhrystone.axf`.

Note: For the application file to be displayed in the Model Debugger Select Targets dialog, you must also specify the remote CADI simulation. See the -c option. |
| -C    | --parameter parameter | Set one model parameter. Specify it as a path naming the instance and the parameter name using dot separators. For example, `foo.bar.inst.parameter=1000`. To set multiple parameters, use --config-file. |
| -c    | --connect simulation_id | Connect to a remote CADI simulation. `simulation_id` specifies the simulation to connect to. --list-connections displays the list of available connections. |
| -E    | --enable-verbose msgClass | Use verbose messages if displaying message text for message classes `msgClass`. Without an argument, this option lists all classes. |
| -e    | --env-connect | Connect to remote CADI simulation using the following environment variables:
  - CADI_CLIENTPORT_TCP – port number
  - CADI_INSTANCEID – component instance name
  - CADI_APPLICATIONFILENAME – application file name |
| -F    | --stdout-to-file FILE | Print all application output to `FILE` instead of the StdIO pane in the Output Window. |
| -f    | --config-file filename | Use model parameters from the configuration file `filename`. |
### Table 2-1 Command-line options (continued)

<table>
<thead>
<tr>
<th>Short</th>
<th>Long option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h</td>
<td>--help</td>
<td>Print the available options and exit.</td>
</tr>
<tr>
<td>-i</td>
<td>--instance</td>
<td>Specify the instance.</td>
</tr>
<tr>
<td>-L</td>
<td>--cadi-log</td>
<td>Log all CADI calls into an XML logfile CADILOG-nnnn.xml, where nnnn is a set of four digits. The logfile is created in the same directory as the model.</td>
</tr>
<tr>
<td></td>
<td>--list-connections</td>
<td>List possible connections to remote CADI simulations on the local machine and exit afterwards. Each simulation has a unique simulation ID.</td>
</tr>
<tr>
<td></td>
<td>--list-instances</td>
<td>List target instances.</td>
</tr>
<tr>
<td>-l</td>
<td>--list-params</td>
<td>List target instances and their parameters.</td>
</tr>
<tr>
<td>-m</td>
<td>--model filename</td>
<td>Load the specified model.</td>
</tr>
<tr>
<td>-N</td>
<td>--nogui</td>
<td>Run the simulation without displaying the GUI.</td>
</tr>
<tr>
<td>-n</td>
<td>--no-params-dialog</td>
<td>Do not display the parameter configuration dialog at startup.</td>
</tr>
<tr>
<td>-O</td>
<td>--stdout-to-stdout</td>
<td>Print all application output to stdout instead of the StdIO pane in the Output Window.</td>
</tr>
<tr>
<td>-p</td>
<td>--project filename</td>
<td>Load the project file filename.</td>
</tr>
<tr>
<td>-q</td>
<td>--quiet</td>
<td>Suppress all Model Debugger output.</td>
</tr>
<tr>
<td></td>
<td>--plugin</td>
<td>Load specific trace plug-ins. The equivalent environment variable is FM_TRACE_PLUGINS.</td>
</tr>
<tr>
<td>-V</td>
<td>--verbose</td>
<td>Equivalent to --enable-verbose &quot;MaxView&quot;.</td>
</tr>
<tr>
<td>-v</td>
<td>--version</td>
<td>Print the tool version and exit.</td>
</tr>
<tr>
<td>-x</td>
<td>--force-reg-hex</td>
<td>Force registers with initial integer display to be hexadecimal format instead.</td>
</tr>
<tr>
<td>-Y</td>
<td>--layout filename</td>
<td>Load the layout file filename.</td>
</tr>
<tr>
<td>-y</td>
<td>--no-target-dialog</td>
<td>Suppress the Select Target dialog box that normally appears when a model is loaded. Model Debugger automatically connects to targets that have the executes_software flag set. From the GUI, you can use the Other Settings check box in the Preferences dialog box to suppress the Select Target dialog box.</td>
</tr>
</tbody>
</table>

#### String syntax

Filenames and similar strings that are specified when starting Model Debugger from the command line must be within double quotes if there is white space in the string.

For example:

```plaintext
modeldebugger -a "cluster0.cpu0=my application.axf"
```

There is, however, no requirement to use quotes if the string has no spaces. Both of these forms are valid:

```plaintext
modeldebugger -a cluster0.cpu0=dhrystone.axf
modeldebugger -a "cluster0.cpu0=dhrystone.axf"
```
**Configuration file syntax**

You can configure a model that you start from the command line with Model Debugger by including a reference to an optional plain text configuration file. Each line of the configuration file must contain the name of the component instance, the parameter to be modified, and its value.

Use this format:

```
instance.parameter=value
```

The `instance` can be a hierarchical path, with each level separated by a dot “.” character. If `value` is a string, additional formatting rules might apply.

You can include comment lines beginning with a `#` character in your configuration file. Boolean values can be set using either `true/false` or `1/0`, for example:

```
# Disable semihosting using true/false syntax
coretile.core.semihosting-enable=false
# Enable VFP at reset using 1/0 syntax
coretile.core.vfp-enable_at_reset=1
# Set the baud rate for UART 0
baseboard.uart_0.baud_rate=0x4800
```

**Related references**

[String syntax on page 2-16]

**Running Model Debugger without a GUI**

Model Debugger can be run without a Graphical User Interface (GUI). This mode is triggered by the command-line option `--nogui`.

To limit the duration of a simulation in non-GUI mode, specify the amount of seconds or system cycles using the command-line options:

```
• --timelimit time_in_seconds
• --cyclelimit number_of_system_cycles
```

The `--timelimit` and `--cyclelimit` options are only available in `--nogui` mode.

---

**2.1.2 Launching from System Canvas**

This section describes how to launch Model Debugger from System Canvas.

**Procedure**

1. Open the **Debug Simulation** dialog box:
   - Click the **Debug** button on the toolbar.
   - Select **main menu > Project > Launch Model Debugger**.

**Results:** The **Debug Simulation** dialog box appears.

**Note**

If you have loaded a model, the **CADI library** option and the **Application** field are available for use.
2. Click **OK**.

   **Results:** Model Debugger starts.

**Using the Configure Model Parameters dialog box**

This section describes how to configure models.

If you had not yet loaded a model at the time that Model Debugger starts:

1. Select **File > Load Model**.
2. In the Load Model dialog box that appears, locate and select the required model, then click **Open**.
3. A dialog box appears:
Figure 2-2 Configure Model Parameters dialog box

If you had already loaded a model before Model Debugger starts, Model Debugger checks the available components and opens a similar dialog box.

Note
The exact contents and titles of the panes might differ because they depend on the model.

The Configure Model Parameters dialog box has the following sections:

Parameter category
This pane contains a hierarchical list of the component parameters by category. To expand the view, click the + symbol. To collapse the view, click the - symbol.

Parameter setting
The parameter values are displayed in the right-hand pane.
To toggle between hexadecimal or decimal views, use the box in the lower left corner of the window.

Note
The name of this pane varies, depending on the model, but its purpose and usage is the same in all cases.

To view the configuration parameters as a single list, click the List View tab. The Tree View is similar, but shows the same parameters in a grouped hierarchy.
Set the parameters for the model and click **OK** to close the Configure Model Parameters dialog box.

### Using the Select Targets dialog box

After closing the Configure Model Parameters dialog box, the Select Targets dialog box appears. Select those components that can be debugged in the model.

1. Click the box next to the components that are to load.
2. The **Application file** column displays applications to load for the processors. If the correct application is not selected, click in the field and enter the name of the source file.
3. If the application name in the list is the same as the application that was already loaded, the debug information is automatically loaded to the debugger.
4. Click **OK** to close the dialog box.
5. One or more instances of Model Debugger are created, depending on how many targets you selected to load.
If the application is loaded and the source code can be found from the debug information in the specified file, Model Debugger displays the code in the source window.

If the debug information cannot be found because, for example, the Application file field is empty, use the Load Application dialog box to specify the location for the source code.

**Using the Load Application dialog box**

If the application and source code are not loaded automatically, select File > Load Application to locate and load the code manually.

![Load Application dialog box](image)

Reset the component after loading the source.

_________ Note _________
The Load Application dialog box only displays if you have loaded a model from Model Debugger.

---

### 2.1.3 Launching Model Debugger separately

You can use Model Debugger to connect to and debug a remote *Integrated SIMulator* (ISIM) that has a CADI interface.

**Procedure**

1. Launch your ISIM executable with the `-S` option to start a CADI server.
2. Launch Model Debugger.
3. To display the Model Debugger **Connect remote** dialog box, select File > Connect to Model :

![Connect remote dialog box](image)

4. Select the required simulation instance and click **Connect**.
5. Select a target, for example the processor, and click **Connect** to connect to the specific component instance in the simulation.

![Select Target dialog box](image)

**Figure 2-7 Select Target dialog box**

If you select more than one instance, one Model Debugger window opens for each component. Click **OK** to close the dialog box.

6. If no application loads, select **File > Load Application Code**. Select the application image from the Load Application dialog box and click **Open**.

---

**Note**

If the application loads and the debug information in the application file allows it, Model Debugger displays the source code in the source window.

### 2.1.4 Starting simulations and connecting automatically

In Model Debugger, you can start a SystemC or **Integrated SIMulator** (ISIM) model simulation and then connect to it.

**Procedure**

1. Select:
   - **File > Debug Isim System** … to display the **Debug Isim System** dialog box.
   - **File > Debug SystemC Simulation** … to display the **Debug SystemC Simulation** dialog box.
2. Select a simulation and optionally an application (and parameter file for an ISIM only). If a file is missing, an error message appears. Click **OK** to start the simulation and connect.

**Results:** The **Select Targets** dialog box appears.

**Related tasks**

2.1.3 Launching Model Debugger separately on page 2-21

**Related references**

2.9 Preferences dialog box on page 2-69
2.2 Model Debugger application windows

The Model Debugger GUI consists of the main menu, the toolbar, and the workspace with dock windows.

This section contains the following subsections:
• 2.2.1 Workspace on page 2-24.
• 2.2.2 Main toolbar on page 2-25.
• 2.2.3 Menu bar on page 2-28.
• 2.2.4 Dock windows on page 2-35.
• 2.2.5 Moving or copying views on page 2-35.
• 2.2.6 Saving the window layout on page 2-36.
• 2.2.7 Opening new debug views on page 2-38.
• 2.2.8 Closing windows and views on page 2-39.
• 2.2.9 Output window on page 2-39.

2.2.1 Workspace

The workspace can contain various view types.

• Source code.
• Disassembly.
• Call stack.
• Thread.
• Register.
• Memory.
• Global variables.
• Local variables.
• Output.
• Watch.

By default, the layout does not contain the thread, global variable, or watch windows.

The workspace layout can be customized by opening views, closing views, or specifying options in the Preferences dialog box.

All views can be moved or resized. Project files enable saving and restoring the customized layout. The files can give each processor target type, and even each target instance, a unique appearance.
2.2.2 Main toolbar

The main toolbar provides buttons for frequently used functions. If the functionality is not available in the current context, the buttons are grayed out.

Figure 2-10 Main toolbar
**Open**
Click to open a model library and application file. When the button is clicked:
1. If a model library is not already open, a dialog box is displayed to enable you to select a model library to load.
   Select the model library and click **OK**.
2. If an application is not already open, a dialog box opens to enable you to select the application file to load into the target.
   Select the application file and click **OK**.
3. If a model library and application are already open, a dialog box is displayed to select the source file for the application.
   Select the source file and click **OK**.

**Note**
You might use a Symmetric MultiProcessing (SMP) model with more than one processor, such as one based on the Cortex®-A9 processor. In this case, Model Debugger only loads one image that is run on all processors. All Model Debuggers that are attached to the SMP model load the debug information for that image. This feature is called SMP awareness.

In certain circumstances, you can switch SMP awareness on or off by using the Model Debugger Preferences dialog box.

**Bkpts**
Click to open the breakpoint manager.

**Run**
To run the simulation until a breakpoint is hit or some exception occurs, click this button. Encountering a simulation halt is an example of an exception that stops simulation.

**Pause/Cont**
Click to pause or continue the current high-level simulation step command. An example would be a source-level step. The button text and icon changes depending on whether the simulation is running (**Pause**) or stopped (**Cont**).

You can interrupt high-level simulation control commands with breakpoints before completion. These commands can be completed by clicking the **Cont** button.

**Stop**
Click to stop the execution of the model being debugged.

**Step**
To execute until the simulation reaches a different source line, click to cause a source-level step.

**Over**
To execute the simulation and step over any function calls, click to cause source-level steps.

**Out**
To execute control command until the current function is exited, click to cause source-level steps.

**i Step**
Click to advance the simulation by executing one source-level instruction.
i Over
Click to advance the simulation by one source-level instruction without following any call instructions.

________ Note ________
Not all model targets support this command.

i Out
Click to advance the simulation until a return instruction is executed.

________ Note ________
Not all model targets support this command.

i Step n
Click to advance the simulation by executing the number of source-level instructions that are specified in the <-n-> control.

Cycle
Click to advance the simulation by a single cycle.

Cycle n
Click to advance the simulation by the number of cycles that are specified in the edit box. The default is 1000 cycles.

<-n->
Enter the number of cycles to step if the Cycle n or Back n buttons are clicked. The default is 1000 cycles.

If the i Step n button is clicked, this control indicates the number of instructions to step.

Back n
Click to step the simulation backwards by the number of cycles that are specified in the edit box. The default is 1000 cycles.

________ Note ________
Not all model targets support this command.

Back
Click to step the simulation backwards by one cycle.

________ Note ________
Not all model targets support this command.

Reset
Click to cause a reset of the target model. The application is reloaded.

________ Note ________
For best results, Arm recommends the syncLevel of the model should be 1 or higher when using this command.
Main

Click to cause a reset of the target model. The application is reloaded. The model runs until the `main()` function of the application source code is reached.

--- Note ---

- This command is only available if a `main()` function can be found in the debug information of the application file.
- For best results, Arm recommends the `syncLevel` of the model should be 1 or higher when using this command.

Related references

2.9 Preferences dialog box on page 2-69

2.2.3 Menu bar

The main menu bar provides access to most Model Debugger functions and commands.

File menu

The File menu has the following options:

Open Source …

Opens the source code for the application.

Source File Manager …

Displays the Source File Manager dialog box.

Load Application Code …

Loads application code to the model.

Load Application Code (Debug info only) …

Loads debug information only.

Load Model …

Loads a model.

Connect to Model …

Displays the Connect to Target dialog box to connect to a model file.

Debug Isim System …

Displays the Debug Isim System dialog box to start and debug an isim system.

Debug SystemC Simulation …

Displays the Debug SystemC Simulation dialog box to start and debug a SystemC simulation.

Close Model

Closes the currently open model. If Model Debugger is connected to a CADI server, the connection is closed but the simulation continues to run.

Open Session …

Opens a previously saved session.

Save Session

Saves the current debug session.

Save Session As

Saves the current debug session to a new location and name.
Preferences

Displays the Preferences dialog box to enable you to modify the user preferences.

Recently Opened Models

Displays a list of the most recently opened model files. To open the file, click a list entry. By default, the last 16 files are displayed in the list. The number of files to display can be set in the Preferences dialog box.

To remove a file from the list, move the mouse cursor over the file name. Press the Delete key or right click and select Remove from list from the context menu.

Recently Opened Applications

Displays a list of the most recently opened applications. To open the application, click a list entry. By default, the last 16 applications are displayed in the list. The number of applications to display can be set in the Preferences dialog box.

To remove an application from the list, move the mouse cursor over the application name. Press the Delete key or right click and select Remove from list from the context menu.

Recently Opened Sessions

Displays a list of the most recently opened sessions. To open the session, click a list entry. By default, the last 16 sessions are displayed in the list. The number of sessions to display can be set in the Preferences dialog box.

To remove a session from the list, move the mouse cursor over the session name. Press the Delete key or right click and select Remove from list from the context menu.

Exit

Ends Model Debugger. If you have modified files or sessions, a dialog box prompts you to save your changes.

Search menu

The Search menu has the following options:

Find …

Opens a dialog box that enables searching for a string in a currently active window.

Find Next

Repeats the last defined search to find the next occurrence.

Find Previous

Repeats the last defined search, but the search direction is backwards in the document.

Control menu

The Control menu has the following options:

Note

When using options that reset the model, Arm recommends the syncLevel should be 1 or higher, for best results.

Hard Reset

This option resets the target model without reloading the application.

Reset

Click to cause a reset of the target model. The application is reloaded automatically.
Goto Main
Causes a reset of the target model. The application is reloaded. The model runs until the main() function of the application source code is reached.

Note
This command is only available if a function main() can be found in the debug information of the application file.

Run
Run the simulation until a breakpoint is hit or some exception occurs. An example would be simulation halt.

Pause/Continue Source Step
Pause or continue the current high-level simulation step command. An example would be a source-level step.

Source Step Over
Cause a source-level step to execute until the simulation reaches a different source line.

Source Step Out
Cause source-level steps to execute control command until the current function is exited.

Instruction Step
Advance the simulation by executing one source-level instruction.

Instruction Step Over
Advance the simulation by one source-level instruction without following any call instructions.

Note
Not all model targets support this command.

Instruction Step Out
Advance the simulation until a return instruction is executed.

Note
Not all model targets support this command.

Instruction Step n
Advance the simulation by the number of instructions in the <- n -> edit box. The default is 1000 cycles.

Cycle Step
Advance the simulation by a single cycle.

Cycle Step n
Advance the simulation by the number of cycles in the edit box. The default is 1000 cycles.

Enable/Disable Step Back
Enable or disable stepping back by cycles.

Note
Not all model targets support this command.
**Back**
Step the simulation backwards by one cycle.

___ Note ___
Not all model targets support this command.

**Back n**
Step the simulation backwards by the number of cycles in the edit box. The default is 1000 cycles.

___ Note ___
Not all model targets support this command.
Configure cores for MP stepping …

To enable independent execution of cores, that is, targets, use the **Configure cores for MP stepping** dialog box.

![Configure cores for MP stepping dialog box](image)

**Figure 2-11 Configure cores for MP stepping dialog box**

In cluster (multiprocessor) debugging, each Model Debugger window is connected to a particular target, and the controls in that window apply only to that target. It is the simulation that determines how other connected targets behave when you click **Stop**, **Step**, or **Run** within a window. Typical behavior is to stop and run the whole simulation.

You use the **Configure cores for MP stepping** dialog box to enable Model Debugger to override the default behavior. Model Debugger can control each target to which it is connected. It can force that target to stop executing code while the simulation is running or stepping. In that instance, Model Debugger does not stop any target to which it is not connected. To stop during independent stepping, connect to a target, even if you do not specifically want to view or control that target.

Note

The **Configure cores for MP stepping** dialog box is only enabled if you have loaded a model.

---

The available MP stepping modes are as follows:

- **Use Default - step whole simulation** to place all execution control with the simulator. In this mode, Model Debugger does not explicitly stop any targets.

- **Foreground core only - other attached targets are stopped** enables the foreground target to run, and to stop all other targets to which it is connected.

  Note
  
  The foreground target is the target that is associated with the window that you have selected to run.

- **Custom - single-step selected targets together** enables a fixed set of targets to run, and to stop all other targets to which Model Debugger is connected. This mode disables step and run controls for deselected targets.
Debug menu
The Debug menu has the following options:

Display Messages
Display debug messages.

Clear Log
Clear the log of debug messages.

Clear Model Output
Clears all output messages from the model.

Clear Output Summary
Clear the summary output messages.

Breakpoint Manager …
Display the Breakpoint Manager dialog box.

Profiling Manager …
Display the Profiling Manager dialog box.

Note
Fast Models does not use the profiling options.

View Profiling …
Display the Profile Information dialog box.

Note
Fast Models does not use the profiling options.

Save Model State …
Save the current model state. If reloaded, simulation continues from the point where the model state was saved.

Restore Model State …
Reload a previously saved model state.

Load Debug Info for Module
Load debug information for the module.

Set Parameters
Set parameter values for the model.

Select Targets
Select the execution target within the model.

Layout menu
The Layout menu has the following options:

Layout Control Window
To set layout options such as tiling, display this window.

Load Layout …
Load a previously saved window layout.
Save Layout …
   Save the current layout. Model state is not saved.

Load Recent Layout
   Use a recently used window layout.

Restore Default Layout
   Restore the window layout to the defaults. This option is useful if the layout has become disorganized.

Window menu
The Window menu has the following options:

New View
   Display a new debug view.

Hide
   Hide an existing debug view.

Show
   Display view that was most recently hidden.

Show All
   Displays all previously hidden views.

Close
   Close the window in focus.

Arrange Horizontally
   Tile all view windows horizontally.

Arrange Vertically
   Tile all view windows vertically.

Move
   Move a view to the new position specified on the submenu.

Docked Views
   Dock or undock the view list on the submenu.

Help menu
The Help menu has the following options:

Help …
   Opens this book in Adobe Acrobat Reader.

About …
   Displays the standard About dialog box displaying version and license information.

About Model …
   Opens the text file that contains the release notes.
2.2.4 Dock windows

Model Debugger provides dock windows that can be docked inside the main workspace or floated as a top-level window. To toggle between the docked and floating state, double-click on the dock window handle or the title bar of the floating window.

2.2.5 Moving or copying views

Move or copy debug views within the same dock window or copied by dragging and dropping into another dock window.

To start a drag-and-drop operation, left-click the debug view and, while holding the mouse button down, press the F9 key.

A gray box on the left edge near the bottom of the Model Debugger window indicates the target location. Releasing the mouse button drops the window into the gray box.
To copy the window, press Ctrl+F9. This action effectively duplicates the existing view. A gray box near the center of the Model Debugger window indicates the location for the duplicate view for the Local Variables window. Releasing the mouse button creates the duplicate window in the target location.

![Model Debugger screenshot](image)

**Figure 2-13** Duplicating a register view

---

**Note**

The windows might be difficult to place into the required position. To force the window to dock to a particular location, select the window handle and right-click to display the context menu. The options are: Dock Bottom, Dock Left, Dock Right, and Dock Top. It might take several moves to force the window to the required location.

---

### 2.2.6 Saving the window layout

If you use different debug windows and views for different models, you can save and later reload layouts to simplify reorganizing the views.

The **Layout** menu has the following entries:
Layout Control Window
Displays the window. To change focus to the selected window, click an entry.

Figure 2-14  Layout Control window
Right-click to display a context menu for moving or duplicating windows.

Figure 2-15  Layout Control context menu

——— Note ------------
You can also use drag-and-drop within the Layout Control window to change the location of the windows.
Load Layout

Load a previously saved layout file. The window positions match the window configuration present when the layout was saved.

![Load Layout dialog box](image)

**Figure 2-16 Load Layout dialog box**

Save Layout

Save the current window arrangement to a layout file.

Load Recent Layout

Load the last saved layout. If you have modified the current layout, a prompt asks whether to save the current layout.

Restore Default Layout

Use the default layout.

### 2.2.7 Opening new debug views

This section describes how to open new debug views.

To open a new window:

- Select **New View** from the **Window** menu and selecting the required type of debug view.
- Click the **View** icon at the right of the menu bar and select a view from the list.
2.2.8 Closing windows and views

This section describes how to close windows and views.

You can close a dock window, and all views in the window, by clicking the close button in the dock handle or title bar. This action closes all views in the window.

To close views individually, click the specific close icon.

2.2.9 Output window

This window displays messages from Model Debugger and from the debugging targets.

The window has the following tabs:

Log

Debugger messages, such as errors and warnings.

StdIO

Output from the target model.

All

An interleaved view for both the Log and StdIO messages.
Related references
2.9 Preferences dialog box on page 2-69
2.2.6 Saving the window layout on page 2-36
2.3 Debug views for source code and disassembly

The Source code and Disassembly views share a common window.

Each view consists of:

• A title bar with controls for selecting a target line or switching between views.
• The actual code browser for source or disassembly.
• Columns for line number or address.

The function of the columns and title bar controls is specific to each view.

This section contains the following subsections:

• 2.3.1 Source view on page 2-41.
• 2.3.2 Disassembly view on page 2-45.
• 2.3.3 Call Stack view on page 2-47.

2.3.1 Source view

This section describes the Source view.

The Source view on the left contains two columns with a gray background that contain the line number and bullets that represent executable code locations. The right side of the view contains your source code.

The button with the green arrow scrolls the code browser to the location of the statement or instruction that is to be executed next. You can find this button at the top left of the Source view window.

![Figure 2-19 Arrow button for scrolling code](image)

To highlight the corresponding addresses in the disassembly view, click the left-most column in the Source view. The highlighting reveals the instructions the source statement maps to.

——— Note ———

Highlighting is only available for source lines with a bullet. The bullet indicates that the line is executable.

———

To set a breakpoint on the source line, double click a bullet. A filled red circle is displayed next to the line to indicate that a breakpoint has been set.

![Figure 2-20 Source view](image)
The **Source view** title bar has controls for:
- Selecting a target line in the source using the **Line:** entry box.
- Selecting a source file that has already been loaded using the **File:** drop down list.
- Opening the Debug Source Files dialog box.

**Context menu for Source view**

Right click in the **Source view** to display the context menu. The menu has the following options:

**Insert Breakpoint**
Insert a breakpoint at the selected location.

**Enable Breakpoint**
Enable the breakpoint at the selected location.

**Breakpoint Properties**
If a breakpoint is present on the selected instruction, selecting this option displays the **Breakpoint properties** dialog box.

**Run to here**
Run to the selected instruction.

**Word wrap**
Wrap the text to fit inside the window.

**File properties**
Display the filename and path for the file.

**Debug Source Files dialog box**

The **Debug Source Files** dialog box lets you locate source files that are required for debugging an application. To open the dialog box, click the icon in the upper right corner of the **Source view**.

--- **Note** ---

Pathnames appear with slash (/) characters, even on MS Windows. This fact does not affect operation.

![Debug Source Files dialog box](image)

**Figure 2-21  Debug Source Files dialog box**

The tabs switch between two different views that list the properties for the source file:
Filename

This column contains a list of files that the debugged application refers to. This column is not shown in Hierarchy view.

Debug pathname

This column shows the path for the file. The pathname comes from the debug information of the application. This path might be invalid because it refers to the original source file at compilation time. The debug pathname can be absolute or relative to the executable.

Actual pathname

This column contains the path Model Debugger actually uses to locate the file. You can set the path by double clicking a row or selecting a row and clicking Open File. The File Open dialog box enables selecting the source file. After selecting the file, the file is opened in the debugger.

Click Find File to display the Find source file dialog box and navigate to the directory containing the source.

![Find Source File dialog box](image)

**Figure 2-22  Find Source File dialog box**

Click Properties to display the File Properties dialog box for the selected file. You can also use the Find File button in the File Properties dialog box to locate the file.

![File Properties dialog box](image)

**Figure 2-23  Source File Properties dialog box**

Model Debugger has an automatic mechanism to add replacement paths that are invoked every time you are prompted to find a source file. If the source file is found, an automatic source path replacement is calculated.
This path might not always be correct. There are situations where you must manually edit source path replacements because the automatic path is wrong for that context. You might, for example, have a header file whose name is common between two different compilers, and Model Debugger chooses the wrong one.

Click **Source Paths…** to open the **Source Path Replacements** dialog box. Use this dialog box to change the path, or priority of the paths, to the source files for the application.

--- **Note** ---

The source path replacements are stored in the Model Debugger session file and not with user preferences.

---

Existing source file replacements are displayed in the top part of the **Source Path Replacement** dialog box. You can remove or reorder paths by highlighting an entry and clicking one of the following buttons:

**Move Up**
- Move the path up one position in the list.

**Move Down**
- Move the path down one position in the list.

**Remove Entry**
- Delete the path from the list.

**Debug Path** and **Actual Path** have the same meaning as in the **Debug Source Files** dialog box.

In the lower part of the **Source Path Replacement** dialog box, you can add new source paths or modify existing ones. The additional features are:
Debug info paths

Provides a tree view that simplifies navigation through the debug paths in the debug information of the source file.

Browse

Click this button to select a path with a browser rather than typing in the actual path directly.

Apply Changes

Modify the selected entry using the entered changes.

Insert as New Entry

Adds the new path to the source path replacement list.

Searching in source files

You can search for text in the active window by using the Find dialog box. Click Find on the Search menu to open the Find dialog box.

Figure 2-25  Find dialog box

Type the text in the box and click the Find Next or Find Previous buttons to search upwards or downwards. Re-use previous search terms by clicking the drop-down arrow on the right of the text entry box.

The dialog box is modeless, so you can change views without closing it. The mode is updated automatically.

2.3.2 Disassembly view

The Disassembly view provides four columns for breakpoints and PC indicator, address, opcode, and disassembly string.

If your target model has TrustZone® support, disassembly breakpoints from all worlds appear in the first column. The filled red circles indicate a breakpoint in the world in the disassembly view, and unfilled red circles indicate breakpoints in other worlds.

The green arrow indicates the actual position of the PC.

To display the whole disassembly in a help bubble, move the cursor over a disassembly line. This function is useful if the complete disassembly string does not fit horizontally into the view.
The Disassembly view title bar has the following controls:

**Address:**

Enter a start address to display the code from.

**Memory space:**

Select **Secure** (TrustZone) or **Normal** memory space, if applicable for the processor architecture.

**Architecture**

Select the disassembly mode or instruction sets for the opcodes, such as **Arm** or **Thumb®**.

**Mapping source lines to the disassembly listing**

To highlight in blue the corresponding addresses in the disassembly view, click the left-most column in the source view. The highlighting indicates the disassembly instructions to which the respective source statement maps.

--- **Note** ---

This action is only possible for source lines with a bullet point.

---
Context menu for Disassembly view

Right-click one in the Disassembly view to display the context menu. The menu has the following options:

Insert/Remove Breakpoint

Insert/Remove a breakpoint on the selected location only in the current shown memory space (TrustZone world). The same can be achieved with a double click in the first column.

Insert/Remove Breakpoint into/from all Program Memories

Insert/Remove a breakpoint on the selected location in all program memory spaces.

Enable/Disable Breakpoint

Enable/Disable the breakpoint at the selected location.

Breakpoint Properties

If a breakpoint is present on the selected location, selecting this option displays the Breakpoint properties dialog box.

Show memory

Select a memory space and update the Memory view to display the memory contents at the address specified corresponding to the instruction location.

Run to here

Step the code until the selected location is reached.

2.3.3 Call Stack view

The Call Stack view displays the call history.

To use the Call Stack view, DWARF register mapping must be defined for the architecture and provided in the model.

```
int brot(long sx, long sy)
{
   int count;
   long px = sx, py = sy;
   for (count = 0; count < 256; count++) {
      long px2, py2;
      px2 = px*px >> SHIFT;
      py2 = py*py >> SHIFT;
      // terminate when (px2 + py2) > 2^32:
      if (px2 + py2 > 2^32) {
         return count;
      }
   }
}
```

--- Note ---

The loaded application must be an ELF file that contains a .debug_frame section. No other type of debug information is supported for the call stack view. The .debug_frame section must contain valid
DWARF debug information that matches the DWARF 2 or DWARF 3 specification. The C compiler provides this information to describe all necessary information to unwind the stack:

- The stack pointer.
- How to retrieve the previous frame pointer.
- All registers that are involved in the unwinding process.

Only the frame section can supply this information.
2.4 Debug views for registers and memory

This section describes the views that relate to register or memory contents.

This section contains the following subsections:

• 2.4.1 Register views on page 2-49.
• 2.4.2 Memory view on page 2-51.
• 2.4.3 Variables view on page 2-53.

2.4.1 Register views

This section describes the register debug views.

The Register view displays registers and their values and organizes them into multiple groups. A combo box enables switching between the groups that the target model predefines.

For each register, a buffered state of the register (previous value) is stored. To view the contents:

• Use the context menu in the Register view and select Show Previous Values.

• Place the cursor over the respective register. The buffered state is updated every time the model execution stops.
Context menu for Register view

Right-click one of the registers in the **Register view** to display the context menu. The menu has the following options:

**Copy**

Copy the contents of the selected register.

**Add to Watch**

Add the selected register to the Watch view.

**Insert Breakpoint**

Insert a breakpoint on the selected register.

**Enable Breakpoint**

Enable the breakpoint at the selected register.

**Breakpoint Properties**

If a breakpoint is present on the selected register, selecting this option displays the Breakpoint properties dialog box.

**Edit Value**

Edit the contents for the selected register.

**Select and show memory at $nnn$**

Select a memory space and update the **Memory view** to display the memory contents at the address that the register contents specify.

**Show memory at $nnn$**

Update the **Memory view** to display the memory contents at the address that the register contents specify.

**Format**

Choose the number base to use to display the register contents. The options are **Default Format**, **Unsigned Decimal**, **Signed Decimal**, **Hexadecimal**, **Binary**, **Float**, or **ASCII**.

**Show Previous Value**

Display the current value and the previous value for the selected register.
Select All
Select the registers in the Register view.

2.4.2 Memory view

This section describes the memory debug view.

The Memory view displays a range of memory starting from the base address that the address field (Addr:) specifies. Enter base addresses as decimal numbers or, by using the prefix 0x, as hexadecimal numbers. Other fields allow for selection of the address space (Space:) and physical memory block (Block:).

![Figure 2-32 Memory view](image)

Context menu for Memory view

To display the context menu, right click one of the cells in the Memory view. The menu has these options:

Insert Breakpoint
Insert a breakpoint on the selected memory location.

Enable Breakpoint
Enable the breakpoint at the selected memory location.

Breakpoint Properties
If a breakpoint is present on the selected memory location, selecting this option displays the Breakpoint properties dialog box.

Edit Value
Edit the contents for the selected memory location.

Select and show memory at nnn
Select a memory space and update the Memory view to display the memory contents at the address that the contents of the memory location specify.

Show memory at nnn
Update the Memory view to display the memory contents at the address that the contents of the memory location specify.

Show disassembly at nnn
Update the disassembly view to display the disassembly contents at the address that the contents of the memory location specify.
Copy
Copy the contents of the selected memory location.

Add to Watch
Add the selected memory location to the Watch view.

Endian
Select the memory model to use to display memory contents. The options are: Default Endian, Little Endian, and Big Endian.

Format
Choose the number base to use to display the memory contents. The options are Default Format, Unsigned Decimal, Signed Decimal, Hexadecimal, Binary, Float, or ASCII.

Fixed column count
Display a fixed number of memory values per row. The width of the memory window determines the number to display.

Increment column count
Increment the number of memory values to display per row.

Decrement column count
Decrement the number of memory values to display per row.

Increment current address
Increment the start address that is used for each memory row.

Decrement current address
Decrement the start address that is used for each memory row.

Increment MAU per cell
Increase the size of the word, that is, the Minimum Addressable Unit (MAU), to be displayed in each memory cell. This option also changes the memory access size. If the chosen access size is not supported, Model Debugger defaults to a size of a single MAU.

Decrement MAU per cell
Decrease the size of the word, meaning MAU, to be displayed in each memory cell. This option also changes the memory access size. If the chosen access size is not supported, Model Debugger defaults to a size of a single MAU.

Load File to Memory …
To load a binary or ASCII file into memory, use the Load File to Memory dialog box.

Save Memory in a File …
To save the contents of memory in a binary or ASCII file, use the Save Memory in a File dialog box.

Memory Display Options
To enable setting column count, view format, endian mode, and MAU per cell, use the Memory Display Options dialog box.

Load File to Memory and Store File to Memory dialog boxes
To load or store the memory contents of the target model, use these dialog boxes.
Enter the file name into the top field of the dialog box. You can use the button next to it to browse for the file. When loading or storing a binary or ASCII file, select the correct button. The Memory Space and Start Address fields are filled automatically from the memory view where you opened the dialog box. You can change the values. Put an end address into the bottom field. When loading a file, unless you enter a value here the maximum address of the memory is used.

If any problems occur, a message appears in the Message field.

2.4.3 Variables view

This section describes the Variables debug view.

Variables are displayed in these windows:
Local Variables window
This window shows all local variables and parameters that are valid for the current PC value, with their type and value.
• A blue letter L before the variable name indicates a local variable.
• A green letter P indicates a parameter.

Figure 2-34  Local Variable view

Global Variables window
This window shows the global variables with their types and values. A green letter G marks them.

Complex values such as structs and arrays or pointers can be expanded by clicking the small cross before the variable name.

Note
To use the variables windows, the loaded application must be an ELF file that contains .debug_info and .debug_abbrev sections. No other type of debug information is supported for this view. The .debug_info section must contain valid DWARF debug information that matches the DWARF 2 or DWARF 3 specification. The model must provide a PC register to enable locating local variables.
For applications that have more than one compilation unit, the units are only loaded when the PC reaches the respective context.

The loading of these compilation units can be triggered manually by selecting **Load Debug Info for Module** from the **Debug** menu. Right-click on one of the variables windows and select **Load Debug Info for Module**.

The displayed dialog box lists the compilation units that can be loaded.

**Context menu for the Variable view**

To display the context menu, right click one of the items in the Global or Local Variable view. The menu has these options:

- **Copy**
  - Copy the contents of the selected variable.

- **Add to Watch**
  - Add the selected variable to the Watch view.

- **Insert Breakpoint**
  - Insert a breakpoint on the selected variable.

- **Enable Breakpoint**
  - Enable the breakpoint at the selected variable.

- **Breakpoint Properties**
  - If a breakpoint is present on the selected variable, selecting this option displays the Breakpoint properties dialog box.

- **Edit Value**
  - Edit the contents of the selected variable.

- **Show memory**
  - Select a memory space and update the **Memory view**. You can display the memory contents at the address of the value of the variable.

- **Show Previous Value**
  - Display the current value and the previous value for the selected variable.

- **Select All**
  - Select the variables in the variable view.

- **Load Debug Info for Module**
  - Load debug information for the module that contains the selected variable.
2.5 Debug views for pipelines

Model Debugger provides options for viewing the pipeline.

The options are:
• The Pipeline Overview window.
• The Pipeline Table.

Pipeline views are only available if your model supports them. If the pipeline icons are gray, not orange, then you cannot view pipeline information.

This section contains the following subsections:
• 2.5.1 Pipeline Overview window on page 2-56.
• 2.5.2 Pipeline Table window on page 2-56.

2.5.1 Pipeline Overview window

The Pipeline Overview window presents the main details of every pipeline stage.

The Pipeline Overview contains the name, program counter, opcode, and disassembly for the stages.

![Pipeline Overview window](image)

2.5.2 Pipeline Table window

The Pipeline Table gives a detailed view of the pipeline stages.

By default, the table shows views for all pipeline stages. Each of the detailed entries has a name and value field.
Columns and rows can be resized by grabbing the lines between them and dragging them.

The cross in the top left corner of every pipeline stage view is the starting point for drag and drop operations. A view can be copied or moved to an empty table cell. If it is dragged beyond the boundaries of the table, a new row or column is added in the direction of the drag.

Double click the first column of a view to set or remove a breakpoint on the field.

Double click the second column of a view to open the field for inline edit of the value. You cannot, however, perform an inline edit of an opcode or disassembly.

**Pipeline Table context menu**

Right click the empty space in the table or in an empty cell to open the context menu.
The context menu has the following entries:

**New Pipeline Stage**
Create a stage and add it to the view.

**Reset to default**
Use the default layout for the Pipeline Table view.

**Insert Row Above/Insert Row Below**
Insert a new row above or below the current cell.

**Insert Column Left/Insert Column Right**
Insert a new column to the left or right of the current cell.

**Remove Row/Remove Column**
Remove the row or column that includes the current cell.

**Save Pipeline Table Layout**
Save the current layout.

**Load Pipeline Table Layout**
Load a previously saved layout and use that configuration in the Pipeline Table view.

**Pipeline Stage Properties dialog box**
To open the Pipeline Stage Properties dialog box, click the orange icon to the right of the cross. You can customize the lists in the Pipeline table with this dialog box. The combo box to the right of the orange icon lists all pipeline stages that are available for the current model. The chosen pipeline stage is displayed in the view underneath. To remove the view from the cell, click the X, located in the right top corner of each list.
Choose the fields to be displayed in the pipeline stage list by checking the boxes or clicking the **Show All** or **Hide All** buttons.

The size of the first column can be set in the **Visible characters in the name column** control.

The optional header can be switched on and off by checking the **Show header** check box.

**Context menu for an entry in the Pipeline Table**

Right click an item in the Pipeline view lists to open the context menu.

The context menu has the following entries:

- **Close Pipeline Stage**
  Select to close the pipeline stage.

- **Copy**
  Select to copy the pipeline field. The field can be pasted into the Watch window.

- **Add to Watch**
  Select to add the pipeline field to the Watch window.
Remove Breakpoint/Insert Breakpoint
The text that appears depends on whether the selected field already has a breakpoint:
• If a breakpoint is present, select Remove Breakpoint to delete it.
• If a breakpoint is not present, select Insert Breakpoint to add a breakpoint.

Enable Breakpoint/Disable Breakpoint
If a breakpoint is present:
• Select Enable Breakpoint to enable it
• Select Disable Breakpoint to retain the breakpoint, but disable it.

Breakpoint Properties
View and set the details and conditions for a particular breakpoint.
This dialog box is also available from the Breakpoint Manager dialog box.

Edit Value
Select to open the chosen field for inline edit.

Show Memory
Select to mark the memory address in the Memory Window.

Format
Select to open the submenu. This menu lets you choose the format for number display.

Select All
Selects all fields in the list.

Pipeline Stage Properties
To change the contents of the Pipeline Stage view, open the Pipeline Stage Properties dialog box.

Pipeline Table
Select to display a submenu for the Pipeline Table.

Related references
2.7.4 Breakpoint Manager dialog box on page 2-66
2.6 Watch window and Expression Evaluator

The Expression Evaluator is located in the Watch window.

To display the window, select Window > New View > New Watch Window.

There are two types of entry in the Watch window:

System variables
Entries in this group are marked with small icons to the left of their name to indicate their origin. They can be manipulated in the Watch window in the same way as in their original view.

Items in this category include:
- Registers.
- Memory locations.
- Pipeline fields.
- Variables from source code.

Expressions for evaluation
These items do not have an associated icon because they are not duplicates of an item in a different view. They cannot have breakpoints set and their value cannot be changed. However, you can edit the expression itself by text in the Name column.

Double click in the left column of an existing entry to add a breakpoint for that variable.

Double click in the right column of an existing entry to edit the contents.

Double click on the last entry in the left column to enter a new expression. Press the Enter key to evaluate the expression.

The following rules apply to the names of the resources in the target:
- Registers must be entered in the form:
  
  $registerGroup.registerName

  If the register name is unique for the whole target, the following shorthand notation can be used:

  $registerName

- Pipeline stage fields must be entered in the form:

  @pipelineStage.fieldName

- Memory locations must be entered in the form:

  memorySpace:address

  The content of a memory location is queried with the following expression:

  *memorySpace:address
The delivered pointer can be type cast into any required type:

```
(typeName*)memorySpace:address
```

The variables of the software running on top of the target processor can be entered using an expression as they appear in the software. They do not require a prefix or quotes. Access components of structs or unions with the '.' or '->' operator according to the C syntax.

Numeric values can be entered in the following formats:

**Integer values**

Integer values can have binary, octal, decimal, or hexadecimal representation. The prefix indicates the representation format:

- Binary numbers have a leading `0b`.
- Octal numbers a leading `0`.
- Hexadecimals have a leading `0x`.
- Literals with no prefix are interpreted as decimals.

**Floating-point values**

Floating-point values can have decimal and scientific representation.

Enter floating-point values in decimal representation (123.456) or in scientific representation with positive or negative exponent (1.23456e2).

To form complex expressions, combine resources, variables, and literals in the target with operators. The expression evaluator has the same operands as the C language and has the same precedence and associativity of operators. Inside the complex expression, the resources of the target can be used if an integer value would be sufficient in a regular C expression.

### Table 2-2 Operator precedence

<table>
<thead>
<tr>
<th>Precedence</th>
<th>Operators</th>
<th>Associativity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>[] -&gt; .</td>
<td>Left to right</td>
</tr>
<tr>
<td>2</td>
<td>! ~ + - * &amp; (unary) (cast) sizeof</td>
<td>Right to left</td>
</tr>
<tr>
<td>3</td>
<td>* (binary) / %</td>
<td>Left to right</td>
</tr>
<tr>
<td>4</td>
<td>+ - (binary)</td>
<td>Left to right</td>
</tr>
<tr>
<td>5</td>
<td>&lt;&lt; &gt;&gt;</td>
<td>Left to right</td>
</tr>
<tr>
<td>6</td>
<td>&lt; &lt;= &gt; =&gt;</td>
<td>Left to right</td>
</tr>
<tr>
<td>7</td>
<td>== !=</td>
<td>Left to right</td>
</tr>
<tr>
<td>8</td>
<td>&amp; (binary)</td>
<td>Left to right</td>
</tr>
<tr>
<td>9</td>
<td>^</td>
<td>Left to right</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>&amp;&amp;</td>
<td>Left to right</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>?:</td>
<td>Left to right</td>
</tr>
</tbody>
</table>
This section contains the following subsection:
- 2.6.1 Context menu for Watch window on page 2-63.

2.6.1 Context menu for Watch window

To display the context menu, right click one of the values in the Watch window.

The menu has these options:

**Paste**

Insert a copied memory, register, or variable into the Watch window.

**Copy**

Copy an item and its value from the Watch window.

**Insert Breakpoint**

Insert a breakpoint on the selected watched item.

**Enable Breakpoint**

Enable the breakpoint at the selected watched item.

**Breakpoint Properties**

If a breakpoint is present on the selected watched item, selecting this option displays the Breakpoint properties dialog box.

**Edit Value**

Edit the contents for the selected watched item.

**Select and show memory at nnn**

Select a memory space and update the Memory view to display the memory contents at the address that the contents of the watched item specify.

**Show memory at nnn**

Update the Memory view to display the memory contents at the address that the contents of the watched item specify.

**Format**

Choose the number base to use to display the watched item. The options are Default Format, Unsigned Decimal, Signed Decimal, Hexadecimal, Binary, Float, or ASCII.

**Increment number of bytes**

Increment the number of memory addresses to display.

**Decrement number of bytes**

Decrement the number of memory addresses to display.

**Select all**

Select all of the watched items.
2.7 Breakpoints in Model Debugger

This section describes how to work with breakpoints in Model Debugger.

This section contains the following subsections:

- 2.7.1 Setting breakpoints in the debug views on page 2-64.
- 2.7.2 Setting conditional breakpoints on page 2-66.
- 2.7.3 Removing and disabling breakpoints on page 2-66.
- 2.7.4 Breakpoint Manager dialog box on page 2-66.
- 2.7.5 Breakpoint Properties dialog box on page 2-66.

2.7.1 Setting breakpoints in the debug views

This section describes how to set different kinds of breakpoint in the debug views.

**Source code view**

The second column contains small bullets for each source line. To set a breakpoint, double click on a bullet.

```
int main(void)
{
    char *strings[N];
    char buffer[N][LOG10_N+1];

    int n = 0;
    int ret = 1;
    char *sorted_buf;
    UNINT32 size,
    UNINT32 count;

    volatile UNINT32 *CLI0_FLAG_BASE = (volatile UNINT32 *)CLI0_FLAG_BASE;
    volatile UNINT32 *dml_flag_base = (volatile UNINT32 *)DML_FLAG_BASE;
    volatile UNINT32 *is_irq_received = (volatile UNINT32 *)IRQ_RECEIVER_ADDR;
    *is_irq_received = TRUE;
```

**Disassembly view**

To set a breakpoint on a line, double click on any column.

```
0x000001420 0C000134: JAL _init_timer
0x000001424 54000000: NOP
0x000001428 main_L1:
0x0000142C 8C011720: LW R1, 6432(R0)
0x000001430 0C0001BC: JAL _start_timer
0x000001434 54000000: NOP
0x000001438 0FFF8BC: JAL _wait_for_irq
0x00000143C 54000000: NOP
0x000001440 0FFF9C70: JAL _reset_irq_received
0x000001444 8C0115A8: LW R1, 5800(R0)
```
Register view

To set breakpoints, double click on the first column, the register name column.

Memory view

To set breakpoints, select **Insert Breakpoint** from the context menu. It is not possible to set a memory breakpoint by double clicking on an address.

Local variables view

It is not possible to set these breakpoints.

Global variables view

It is not possible to set these breakpoints.

Call stack view

To set breakpoints, double click on items in the first column.

--- Note ---

To use this view, the architecture must have a definition of the DWARF register mapping and the model must have DWARF register mapping too. The loaded application must be an ELF file that contains a .debug_frame section.

Pipeline Table

To set breakpoints, double click on the name in the first column.
Watch view

If you copy an item from another view into the Watch view, you can set breakpoints in either the original view or the Watch view.

2.7.2 Setting conditional breakpoints

Some breakpoint objects support conditional breakpoints.

To create a conditional breakpoint:

**Procedure**

1. Set an unconditional breakpoint.
2. Set the conditions for the breakpoint with the Breakpoint Properties dialog box.

**Related references**

2.7.5 Breakpoint Properties dialog box on page 2-66

2.7.3 Removing and disabling breakpoints

This section describes how to inactivate breakpoints.

You can quickly remove a breakpoint by double clicking on it. To inactivate a breakpoint without removing it, disable the breakpoint by right-clicking on the breakpoint and selecting **Disable breakpoint** in the resulting context menu. A disabled breakpoint is shown as a gray, rather than red, circle symbol. Other breakpoint dialog boxes and menus also permit you to configure your breakpoints.

2.7.4 Breakpoint Manager dialog box

Control and maintain all breakpoints through the Breakpoint Manager.

This dialog box lists all breakpoints and provides the breakpoint target location, condition, and target details.

Breakpoints that are hit are highlighted in the breakpoint list with an orange background. The breakpoint is also highlighted in the original view for the item.

In the breakpoint list, select an item to:

- Enable, disable, or remove breakpoints.
- Locate the breakpoint target location in the respective debug view.
- Modify breakpoint conditions using the **Properties** button.

![Figure 2-48  Breakpoint Manager dialog box](image)

2.7.5 Breakpoint Properties dialog box

Open the Breakpoint Properties dialog box by right clicking on a breakpoint and then selecting **Properties** from the resulting context menu, or with the Breakpoint Manager.

Select the breakpoint criteria with the Breakpoint Properties dialog box:
Ignore count
Enter the number of occurrences to ignore before triggering the breakpoint. Enter 0 to trigger a breakpoint for every occurrence.

Enable breakpoint
To enable the breakpoint, check this box. If unchecked, the breakpoint location and type is stored, but occurrences do not trigger a breakpoint.

Continue Execution after hit
To enable the continuation of execution after breakpoint hit, check this box. If checked the execution of the debugged application does not stop when the breakpoint is being hit.

Resource
Select the condition that results in a breakpoint being triggered. Conditional breakpoints are not supported for some types of breakpoint object.

Value
If the Resource type is not breaks unconditional, select the comparison value that is to trigger the breakpoint.

Trigger Type
Select whether a Read, Write, or Modify operation triggers the breakpoint. These check boxes are not enabled for some types of breakpoint object.

Hexadecimal value display
Check to display the contents of the Value field in hexadecimal format. If unchecked, decimal format is used.

Figure 2-49 Breakpoint Properties dialog box
2.8 Model Debugger sessions

Model Debugger session files enable saving and restoring debugging sessions and provide a convenient way to specify the session parameters.

Session files have the extension *\.mvs.

--- Note ---

The session files are only available for directly loaded models. They cannot be used for connections to Model Shell or SystemC simulations.

The information that can be saved and restored includes:
- Debugger main window geometry.
- Layout of all debug views.
- Target model being loaded.
- Application file.
- Breakpoints.

Session files also enable configuring the individual layout of debugger windows for cluster systems. You could, for example, then use the project with SoC Designer.

To save a session, select **Save Session**, or **Save Session As**, from the **File** menu.

To load a session and restore the original model connection and window layout, select **Load Session** from the **File** menu.
2.9 Preferences dialog box

Configure the behavior of Model Debugger with the Preferences dialog box.

![Preferences dialog box](image)

To display the options for that category, select an entry in the list on the left side of the dialog box:

**Appearance**

Each option has a checkbox:

- **Show tool tips** enables display of pop-up help for a control.
- **Display toolbar text labels** displays text below the icon.
- **Word wrap in source window** wraps long lines to fit the window.
- **Show splash screen on startup** displays the information screen.
- **Reload recent layout on startup** keeps your last used layout.

Use the controls in the **Recent files and directories** to control how many previously used files and directories are displayed.

**External Tools**

The **use operating system file associations** checkbox is only available on Windows, and is selected by default. This setting inactivates the external tool edit fields and buttons. To activate these fields, clear the checkbox.

_________ Note _________

The default external tools are different on Linux.

Configure the display of the documentation with these settings. Access the documentation through:

- The **Help** menu item. You access the PDFs for the Model Debugger and Fast Models this way.
- The documentation_file property in a component property listing. This property might point to a PDF file, a text file, an HTML file, or a http:// link.

You can change the default external tools. Click the folder icon to open a browser, or use the drop-down list to choose a previously selected executable.
Fonts

You can specify the fonts for each of the windows.

To control the fonts with the $DISPLAY variable, check Fonts depend on $DISPLAY variable.

Suppressed Messages

Lists the suppressed messages and enables you to specify an action for each message.

Verbose Messages

Turn on or off verbose message setting for the message IDs. To turn on or off individual messages, click Selective.

Other settings

Each option has a checkbox:

• **Load all Compilation Units at Startup**: load all required files.
• **Show Parameter Dialog at Startup**: display the dialog box to configure model parameters.
• **Show Target Dialog at Startup**: display dialog that normally appears when a model is loaded. If unchecked, Model Debugger automatically connects to targets that have the executes_software flag set.
• **Enable SMP Application Loading**: have Model Debugger load the application once into memory and load only debug information for all processors. The PC is set to the value of the first processor in all processors.

After displaying the dialog box and modifying preferences:

• Click **Apply** to apply the settings and keep the dialog box open.
• Click **OK** to apply the settings and close the dialog box.
• Click **Close** to close the dialog box. Unapplied settings changes are lost.
This chapter describes how to install and configure a standalone version of Model Debugger. Model Debugger is automatically installed with Fast Models.

It contains the following sections:

• *3.1 Linux installation procedure* on page 3-72.
• *3.2 Windows installation procedure* on page 3-74.
3.1 Linux installation procedure

This section describes the procedure for installing Model Debugger on Linux.

This section contains the following subsections:

• 3.1.1 Linux software requirements on page 3-72.
• 3.1.2 Linux installation on page 3-72.
• 3.1.3 Linux environment configuration scripts on page 3-72.

3.1.1 Linux software requirements

This section describes the software requirements for using Model Debugger on Linux.

Operating system

• Red Hat Enterprise Linux 6 or 7.
• Ubuntu 16.04 LTS or 18.04 LTS.

PDF reader

Adobe does not support Adobe Reader on Linux. Arm recommends system provided equivalents, such as Evince, instead.

License management utilities

The latest version of the FlexNet software that is available for download from


3.1.2 Linux installation

This section describes how to install Model Debugger.

Unpack the archive and run the setup program:

```
  gunzip ModelDebugger_version.tgz
  tar -xvf ModelDebugger_version.tar
  cd ModelDebugger_version./setup.bin
```

In the sequence of commands, version is the version of Model Debugger you are installing.

The installer prompts you for the target installation directory and creates the following subdirectories:

```
  bin
    Executables.
  doc
    Documentation.
  etc
    Model Debugger setup scripts.
  lib
    Libraries and tool-specific files.
```

3.1.3 Linux environment configuration scripts

Model Debugger provides setup scripts in the etc directory. The appropriate setup script must be executed to configure your environment for Model Debugger.
• For Bourne and related shells, use:
  
  . installation_directory/etc/setup.sh

• For C and related shells, use:
  
  source installation_directory/etc/setup.csh

You might find it more convenient to add a reference to the Model Debugger configuration script to your usual startup script.

The setup script sets the following environment variables:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$PATH</td>
<td>The PATH environment variable is updated to include installation_directory/bin.</td>
</tr>
<tr>
<td>$MAXVIEW_HOME</td>
<td>Set to the Model Debugger installation directory. Model Debugger was previously named MaxView.</td>
</tr>
<tr>
<td>$ARMLMD_LICENSE_FILE</td>
<td>Set to the location of the license file or license server (using port@host syntax) for Model Debugger. See the Arm® License Management documentation for more information. If necessary, you can change this environment variable after installation by editing the setup.[c]sh script.</td>
</tr>
</tbody>
</table>
3.2 **Windows installation procedure**

This section describes the procedure for installing Model Debugger on Windows.

This section contains the following subsections:
- 3.2.1 *Windows software requirements* on page 3-74.
- 3.2.2 *Windows installation* on page 3-74.

3.2.1 **Windows software requirements**

This section describes the software requirements for using Model Debugger on Windows.

**Operating system**
- Microsoft Windows 7 64-bit RTM or Service Pack 1, Professional, or Enterprise editions,
- Microsoft Windows 10 64-bit.

**PDF reader**
- Adobe Acrobat Reader.

**License management utilities**
- The latest version of the FlexNet software that is available for download from

3.2.2 **Windows installation**

This section describes how to install Model Debugger.

**Procedure**
1. Open the distribution archive `ModelDebugger_version.zip` and extract the complete contents into a temporary directory. `version` is the version of Model Debugger you are installing.
2. To start the installer, run the `Setup.exe` program in the temporary directory.
3. When prompted by the installer, specify the target directory for the installation or accept the default directory.
   The installer creates subdirectories in the specified installation directory.

   **bin**
   - Executables.

   **doc**
   - Documentation.

   _____ Note _______

   The installer configures the environment variables for the user who installed the tools. Other users might need to use Model Debugger on the same computer. Either copy the value of the `%MAXVIEW_HOME%` environment variable to the System variables, or have them define the environment variable themselves in Control Panel. Both operations need administrator privileges.
Chapter 4
Shortcuts

This chapter describes shortcuts available in Model Debugger.
It contains the following section:
• 4.1 Keyboard shortcuts on page 4-76.
# 4.1 Keyboard shortcuts

This section describes the keyboard shortcuts.

<table>
<thead>
<tr>
<th>Modifier</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Esc</td>
<td>Close the current dialog.</td>
</tr>
<tr>
<td>-</td>
<td>F1</td>
<td>Help.</td>
</tr>
<tr>
<td>-</td>
<td>F3</td>
<td>Find next.</td>
</tr>
<tr>
<td>Shift</td>
<td>F3</td>
<td>Find previous.</td>
</tr>
<tr>
<td>-</td>
<td>F5</td>
<td>Run target.</td>
</tr>
<tr>
<td>Shift</td>
<td>F5</td>
<td>Stop target.</td>
</tr>
<tr>
<td>-</td>
<td>F10</td>
<td>Source-level step over.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>F10</td>
<td>Source-level step out. This action leaves the current function.</td>
</tr>
<tr>
<td>-</td>
<td>F11</td>
<td>Source-level step into.</td>
</tr>
<tr>
<td>Shift</td>
<td>F11</td>
<td>Instruction-level step.</td>
</tr>
<tr>
<td>Shift</td>
<td>F10</td>
<td>Instruction-level step over.</td>
</tr>
<tr>
<td>Ctrl+Shift</td>
<td>F11</td>
<td>Instruction-level step out.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>F11</td>
<td>Cycle step.</td>
</tr>
<tr>
<td>Ctrl+Shift</td>
<td>F11</td>
<td>Cycle step N.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>B</td>
<td>Open the breakpoint manager.</td>
</tr>
<tr>
<td>Ctrl+Shift</td>
<td>C</td>
<td>Connect to model.</td>
</tr>
<tr>
<td>Ctrl+Shift</td>
<td>D</td>
<td>Load debug information from application code.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>F</td>
<td>Search (find) operation.</td>
</tr>
<tr>
<td>Ctrl+Shift</td>
<td>L</td>
<td>Load model library.</td>
</tr>
<tr>
<td>Ctrl+Shift</td>
<td>M</td>
<td>Go to function main().</td>
</tr>
<tr>
<td>Ctrl</td>
<td>O</td>
<td>Multi-functional open. If no target is loaded, a dialog is displayed to select the model library and application code. If a target is loaded, the source file is opened.</td>
</tr>
<tr>
<td>Ctrl+Shift</td>
<td>O</td>
<td>Load application code.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>P</td>
<td>Open the Model Parameter dialog.</td>
</tr>
<tr>
<td>Ctrl+Shift</td>
<td>P</td>
<td>Pause or continue source step.</td>
</tr>
<tr>
<td>Modifier</td>
<td>Key</td>
<td>Function</td>
</tr>
<tr>
<td>---------</td>
<td>-----</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Q</td>
<td>Close Model Debugger.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>R</td>
<td>Reset target only.</td>
</tr>
<tr>
<td>Ctrl+Shift</td>
<td>R</td>
<td>Reset target and reload application.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>S</td>
<td>Save the current session.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>T</td>
<td>Select target.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>U</td>
<td>User preferences dialog.</td>
</tr>
<tr>
<td>Ctrl</td>
<td>W</td>
<td>Close model.</td>
</tr>
</tbody>
</table>